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Before You Begin 
This guide will help the administrator install Netdoc, configure IIS, and set up SQL 
Server so Netdoc will function properly.  Additional help and information maybe found at 
www.bradyid.com on the Online Knowledge Base.  It’s important to consult you Network 
and Database administrator before performing any installation.  This guide is a basic set 
up structure.   The administrators may require addition settings for security purposes. 

• Internet Information Services (IIS), SQL Server 2000 or greater, and .NET 
Framework 1.1 or higher is required for the NetDoc application to operate.  
Ensure these software packages are installed before going any further. 
 

NOTE: Microsoft’s .NET Framework is essential for the NetDoc 
application to operate properly with IIS.  For that reason, we strongly 
suggest (re)installing the .NET Framework before configuring anything.  
The .NET Framework can be downloaded from www.microsoft.com. 

 
• The person doing the installation will need to be an administrator.  This person 

will be responsible for configuring IIS and SQL and will need the rights to do so. 
 

• It is strongly recommended that a database administrator handle the SQL portion 
of the installation to ensure database security and integrity. 
 

• Refer to the Netdoc User Guide for complete system requirements.  
 

Installation Overview 
To complete the installation and setup of the NetDoc application, you will: 

1. Install Netdoc on your IIS server. 

2. Create the SQL Server Netdoc database to store the data. 

3. Configure the SQL Server security. (optional) 

4. Configure the IIS to display Netdoc on an Intranet. 
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5. Connect Netdoc IIS to Netdoc SQL Server. 

6. Add Netdoc users to view and administrate the software. 

7. Configure the way Netdoc security allows people to log in. (optional) 

 
Installation for Microsoft Windows 2000®, Windows 2003®, and 
Windows XP Professional® 
The NetDoc application uses a Microsoft SQL Server database that is installed on your 
server (see Create the SQL Server Database). Client machines use the NetDoc 
application via the web browser. Below are the setup instructions for setting up the 
NetDoc application on the server: 

1. Insert the NetDoc CD into the CD-ROM drive. The install screen appears. (If the 
install does not start automatically, select Run from the Start menu, type 
D:\setup.exe and skip Step 2.) 

2. Click Install NetDoc. 

3. The NetDoc InstallShield Wizard screen appears, extracting files for the 
installation. Click Next. 

4. Accept the End User License Agreement (EULA) to continue. If you decline the 
agreement, the software will not install. 

5. Enter your User Name, Organization, and Serial Number. The serial number is 
located on the inside cover of the DVD case.  Click Next. 

6. The Choose Destination Location screen appears showing the default directory 
where the NetDoc application will be installed. If you don’t want to use the default 
directory, click Browse to select an alternate installation location for the NetDoc 
application.  
Note: Brady recommends that you use the default installation directory location. 
Not doing so may result in additional IIS configuration steps. 

7. Click Next. 

8. The Setup Type screen appears. Select Install (databases on server). Click 
Next. 

9. The installation process begins. The progress of the installation shows on the 
display bar.  

10. The final screen appears when the installation is complete. Click Finish. 

 
 
Create the SQL Server Database 

1. From the Start menu, choose Programs, then Microsoft SQL Server. Click 
Enterprise Manager. 

2. Locate the SQL Server group where the NetDoc database will reside, for 
instance, SQL_TEST_SERVER. 
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3. Open the database folder, then either right-click on Databases, or choose New 
Database from the Action menu.  

4. The Database Properties window appears. Under the General tab, enter a name 
for the database in the Name field and click OK.  Make a note of the name, as 
you will need it later. 

5. Expand by the database tree clicking the (+) symbols and select the database 
you just created. 

6. Click the Tools menu and select SQL Query Analyzer. 

7. Click the File menu and select Open. 

8. In the Open Query File dialog box, browse to the NetDoc installation location you 
selected in Installation for Microsoft Windows 2000®, Windows 2003®, and 
Windows XP Professional®. The default location is 
C:\Inetpub\wwwroot\NetDoc. 

9. In the root of the NetDoc directory, click the NetDoc.sql file, then click Open. 

10. Click Execute Query. 
 

 
11. Confirm that “Query batch completed” is shown at the bottom of the screen. If 

you receive an error, please consult with Microsoft’s SQL 2000 Server User 
Guide. 

12. Click Exit on the File menu to close the Query Analyzer. 
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Configure SQL Server Security 
1. Start the SQL Server Enterprise Manager by going to Start, Programs, and 

SQL 2000 Server in the windows start menu.  
 
2. Right click the name of your SQL server, then click Properties. 

 

 
 

-Page 5- 



 
3. Click the Security tab.  Under Authentication in the Security section, make 

sure that SQL Server and Windows is selected. 
 

 
 

4. Under Startup service account, select this account and enter the name and 
password of a local administrator account. If you don’t have the administrator 
account information, please contact your IT department. 
 

5. Click OK to close the Properties dialog box. 
 

6. You are now finished configuring the SQL server security.  Close the SQL Server 
Enterprise Manager. 

 
 

Add the Database User in SQL Server 
 
Note: This section provides general guidelines for establishing new database securities 
with in the SQL server.  Please follow these instructions as a guideline. A database 
administrator should perform all SQL configurations due for security purposes. 
 

1. Start the SQL Server Enterprise Manager by going to Start, Programs, and 
SQL 2000 Server in the windows start menu. 
 

2. Expand the tree to show your NetDoc database. 
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3. Right click on Users and select New Database User. 
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4. For the Login name field, click the down arrow and select <new>. 
 

 
 

5. When the SQL Server Login Properties – New Login dialog box appears, type 
the new login name you want and select SQL Server Authentication.  Then 
enter a password.  Make a note of the name and password you entered, as you 
will need this later.  Click OK. 
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6. In the Database User Properties dialog box, click the down arrow next to Login 
name and select your newly added name.  Check the db_owner checkbox, then 
click OK. 
 

 
 

 
7. You should now see your newly added user in the main pane of the SQL Server 

Enterprise Manager window.  You can now close the SQL Server Enterprise 
Manager. 

 
 
 
Configure IIS 
Make sure you complete this step before attempting to connect to the database; without 
configuring IIS first, users will not be able to connect to the database (see Connect to the 
SQL Server Database).  

Configuration for Windows 2003 
1. Launch Windows Explorer. 

2. Browse to the NetDoc installation location. The default location is 
C:\Inetpub\wwwroot\NetDoc. 

3. Right-click on the NetDoc folder and select Properties. 

4. Select the Security tab. 
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5. Select the IIS_WPG user. 
 

 
6. Select the Write check box in the Allow column in the Permissions area. 

7. Click Apply, then click OK. 

Configuration for Windows 2000 
1. Launch Windows Explorer. 

2. Browse to the NetDoc installation location. The default location is 
C:\Inetpub\wwwroot\NetDoc. 

3. Right-click on the NetDoc folder and select Properties. 

4. Select the Security tab. 

5. Click the Add button. 

6. In the Select Users or Groups dialog box, select the ASPNET user and click the 
Add button. 

-Page 10- 



 

 
7. Click OK. 

8. On the Security tab, select the Write check box in the Allow column in the 
Permissions area. 
 

 
9. Click Apply, then click OK. 

10. You are now finished configuring the folder permissions.  You can close 
Windows Explorer. 
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Configure IIS Security 
1. From the Start menu, select Control Panel, select Administrative Tools, and 

open the Internet Services Manager. 

2. In the tree, locate the Internet Information Services name.  Below should be the 
name of your server.  Make a note of this name, as you will need it later. 

3. Expand your server name, then expand the Default Web Site option.  Right-click 
NetDoc and select Properties.  
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4. In the NetDoc Properties dialog box, ensure that the Application Protection 
setting is set to Low. 
 

 

 

5. Click the Directory Security Tab. 
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6. In the Anonymous access and authentication control section, click the Edit 
button. The Authentication Methods dialog box appears. 
 

 

(Windows 2000 Server example) 

7. Make sure Anonymous access is checked as well as Integrated Windows 
authentication.  Everything else can remain as is.  Click OK. 

8. Click OK again to close the NetDoc Properties dialog box. 

9. Close the Internet Information Services window.  You are now finished 
configuring IIS security. 

 

 

Connect to the SQL Server Database  
 
Note: It’s important to disable any pop-up blocker programs.  Netdoc may not function 
properly with pop-up blockers. 

1. Launch Internet Explorer. 

2. Type http://(Server Name)/Netdoc in the browser address field. 

3. Press Enter or click the Go button in the browser. The Netdoc login website 
should appear.  

4. Click Select Database. A pop up window titled Netdoc Data Source should 
appear. 
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5. Enter the name of the Server, Database, User name (see Add Database User 
to SQL), and Password.  This is the information you noted earlier when you 
created the SQL server database and added the database user to the server. 

6. Click Connect. The Netdoc Data Source dialog box closes and the Home Page 
appears, displaying the connected database.  

Create a Contact (optional) 
Note: You will need to create a contact before you configure how users log in.  Contacts 
will be users who will be able to view the content of Netdoc, and Administrators who are 
able to add, edit, and delete the information. 

1. In Internet Explorer, go to the NetDoc Home Page and click Companies under 
the Setup menu on the right. The Company Info page appears. 

2. Click the Add button and a white text box will appear.  

3. Enter the Company Name, Address, City, State, Zip Code, and Phone 
Number. 

4. Click the Save button and close the Window by pressing the “x” on the top right 
hand corner. 

5.  Click the Launch Application link and the cable infrastructure screen will 
appear.  

6. Select Contacts from the drop-down menu on top. 

7. Click the Add button. 

8. Your first user should be the over all administrator of the product.  He will be the 
one responsible for maintaining access to Netdoc.  Enter the information for the 
contact.  

9. Create a User Name and Password. 

10. Check the Administrator check box. 

11. Click Save.  

12. You can now use this new user login information to access Netdoc.  Repeat 
steps 6-11 for each administrator. 

13. Close Internet Explorer. 

 

 

Security Configuration 
This section is to configure the way you log into Netdoc.  There are three basic options; 
No login (none), Netdoc controlled login (forms), Windows/Netdoc control login 
(windows). For ease of use, Brady suggests using the Forms option for Authorization 
Mode and Authentication.  This will allow NetDoc to manage the passwords.  

Configuring security requires three settings to reflect the correct mode: Authorization 
Mode, Authentication, and User Access. These settings already exist in lines in the 
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Web.Config file shipped with the software. (The file can be found in the root of the web 
where it was installed.)  

To access the settings, open the Web.Config file using Notepad or any other text editor 
and locate the lines listed below. See Setting Security for a description of settings and 
user types and instructions for accessing and implementing settings correctly.  

NOTE: Authentication Mode values are case sensitive.  

1. Authorization Mode:  
<add key="AuthMode" value="xxx" />  
Valid values for xxx are: None, Forms, Windows  

2. Authentication:  
<authentication mode= "xxx"/>  
Valid values for xxx are: None, Forms, Windows  

3. User access:  
a) Setting for None/Forms:  
<allow users="*" /> <!-- Allow all users --> 
<!--deny users="?" /--> <!-- Deny all users -->  

b) Setting for Windows  
<!--allow users="*" /--> <!-- Allow all users --> 
<deny users="?" /> <!-- Deny all users --> 
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